
 

2–D Drafting 

LINE  

Creates straight line segments 

With line, you can create a series of straight line segments. Each segment is a line object that can be edited 

separately. 

  
Now it is not required to mention the point 2 as start point of line B again (line B is connected with line A). At 

the point the previous line segment ends, the next line segment starts from that very point itself. This is a 

process of drawing contiguous line segments. 

Line A & line B are adjoined but separate segments in a series, so that can be modified or erased individually.  

To draw any line segment the parameters are required: 

1. Start point – End point. (Points can be either co-ordinate value or any constraint) 

2. Start point – Length & angle 

Example: draw a ‘L’ which vertical length is 200 mm and horizontal length is 100 mm. consider the start point 

(top) of the vertical line is at origin i.e. start point (x,y) = 00,00.  

So, we have to get the values of point a, b & c. 

We know, point a is at origin. 

So,  point a = 0,0; 

Point b = 0,-200 or @200<270 

 Point c = 100,-200 or @100,0 or @100<0 

 

 
Using the option ‘Close’: This option is used to join the end point 

of last drawn segment to start point of first drawn segment. 

Minimum two contiguous line segments required to execute this command. 

 

Using the option ‘Undo’: This option is used to remove the last drawn 

 line segment and return to the previous point. From this option only 

 removes segment from current contiguous line segments. 

 

Line - The segment of minimum length connecting any two points is a line or straight line. 

 

 

Point 1- Start point of line A.  

 Point 2- End of line A. 

again, 
  Point 2- Start point of line B. 
        Point 3- End of line B. 
 

` 

 

 



 

 

Construction line 

Construction line creates a line of infinite length 

Lines that extend to infinity, such as xlines, can be used to create construction and reference lines, and for 

trimming boundaries.  

 

Apart from drawing freestyle construction lines at any angle passing through a common point, some 

conditional methods also exist for our convenience.  

 
 

1) Hor – To draw construction lines parallel to the horizontal axis (X axis).  

 

Here we can specify the distance for creating multiple horizontal construction line. To define the position of 

the construction line respective to the previous line we have to place the point in that direction (upward or 

downward). Using (-) sign while specifying the distance will create the construction line opposite to the 

direction of pointing device. The value and direction is measured from the last drawn construction line of the 

same set. 

2) Ver – To draw construction lines parallel to the vertical axis (Y axis).  

From the figure we can understand the construction 

line (red) are drawn for boundary reference. The 

shaded (blue) part defining the boundary. Later we can 

trim the extended part of the construction line to get 

the area only. 



 

 

 

3) Ang – To draw construction lines at any angle w.r.t horizontal axis. 

 

 

4) Bisect – To draw a construction line through angle vertex point, bisecting the angle. 

 

5) Offset – To draw a construction line parallel to any other line at user specified distance or through 

distance.   

Here we can specify the distance for creating multiple 

vertical construction line. Positive value will create 

construction line at the direction of the pointer and 

the negative value will create opposite to the direction 

of pointing device.  The value and direction measured 

from the last drawn construction line. 

We have to define the angle of the 

construction line. Again we can create 

parallel construction lines by specifying 

the distance. 



 

 

 

Note - While creating horizontal, vertical or angular construction line, we can create any number of 

construction lines at specified distances parallel to the last drawn construction line. The side of drawing the 

lines is controlled by the position of the selection device. The side is defined by positive or negative value 

(followed by ‘-‘sign) of the magnitude of the distance. 

 

Construction line - These are such lines that are of infinite length but the profile is straight, i.e. any part of 

a construction line (length between two imaginary points) is always a straight line. Or we can say a straight 

line extended in both directions to infinity. 

 

 

To trisect any angle 

 

 
 

Let us consider, we have to trisect the angle <CAB.  

Bisect the <CAB, suppose the line AG is bisecting the <CAB.  

Draw an arc PQR, which will intersect the line AG at point Q. Now, join P and R with a straight line. O is the 

midpoint of the line PR.  

The object from which we offset 

the construction line should be 

line segment. 

The offset distance should be 

positive and non-zero value. 



 

Draw a half circle with center O and radius equal to the line OP. The half circle PFR intersects line AG at point 

F.  

Now, divide the half circle (or arc) into three equal parts suppose at point M and N. (Include angle of any half 

circle is 180o. If it is trisected, the include angle of each arc segments will be 180/3 or 60o.) 

Join point P and F with a straight line.  

Now, from point O, take a line segment of length equal to PF on line AG and towards point A. Suppose, the 

line segment is OS. Draw lines SN and SM, which will intersect the arc PQR at points D and E respectively.  

Draw the lines AD and AE.  

Now <BAD = <DAE = <EAC = 1/3 <BAC. 

 

 

 

 

Polyline  

Creates a 2d polyline 

A 2d polyline a connected sequence of segments created as a single planar object. You can create straight line 

segments, arc segments, or a combination of the two. 

 

 

Polyline is a combination of line segment and arc segment.  

First we will discuss about line segment. 

To draw line segment we have to define the values of start point and end point. Points either coordinate value 

or any constrain. 

Using the option ‘Length’ – This option used to define the length of the line segment from its start point 

without altering the angle. 

The figure is a planar object, created 

by Polyline as any of the individual side 

cannot be modified. To draw the 

segments is same like line, defining the 

values accordingly. 

 

In case we define the Length of 

a line segment following an 

arc, the line will always be 



 

 

The magnitude followed by negative sign will create the line segment in opposite direction (towards the start 

point of the previous segment). 

 

Now the arc segment is drawn by defining the parameters like 

 Angle – Include angle of the arc. Then we have to define 

 either the end point, or center point, or the radius of the 

 arc and direction of the chord (angle). 

 

 

 Center – Center point of the arc. Then we have to define either the include angle, or the chord length 

of the arc. 

The rotation of the arc is CCW in this method. 

 Direction – Tangent direction of the arc. Then we have to provide the end point of the arc. 

 Radius – Radius of the arc. Then we have to define the end point or the include angle of the arc. 

 Second pt –  Point followed by the arc apart from start point and end point.  

 

Using the option ‘width’ & ‘halfwidth’ – This option used for both line segment and arc segment to create a 

boundary object of different start and end width. 

 

>> The value of include angle must not be 0o and 
360o. 
>> Positive value turns CCW and negative value turns 
CW direction. 
 



 

 

Using the option ‘Close’: This option used to join the end point of last drawn segment to start point of first 

drawn segment. The closing segment will be same as line or arc depends on the last drawn segment of the set. 

Using the option ‘Undo’: This option used to remove the last drawn segment and return to the previous point. 

From this option only removes segment from current series of segments. 

 

 

 

 

 

 

 

Join – Joins other segments to selected open polyline to convert the whole in a single polyline. In this case, the 

endpoints of the segments must coincide. 

Now, in case of joining any other segment to a open polyline while there is a gap between two segments. 

Then we have to select Multiple option under PEDIT command. Here we have to use the PEDIT command first 

and selecting the segments next in order. 

 

The fuzz distance is the distance larger than the gap to create the connecting segment depends upon the 

Jointype. 

   

 

Select polyline – right click to select Polyline – Edit Polyline or 

Modify – Object – Polyline to edit polyline. 

Close – Closes the polyline to create a boundary, connecting the 

last segment with the first.  

 

Similarly opens the close boundary created by Polyline, using the 

Open command. 

 



 

 

 

 

 

 

 

Width – Specifies width to any polyline. Width can be uniform or vary from vertex to vertex. Using the Edit 

vertex option, we can vary the width in a polyline. 

 

 

Defining the width of any polyline, using the Edit vertex point, we have to define the starting width and ending 

width.  

Use ‘Next’ and ‘Previous’ to select the next or previous segment respectively. 

 

 

The starting width and ending width may be different. 

Edit vertex – specifies the vertex of the polyline with a X mark 

 Next – Prompts the next vertex of the polyline. 

Extend – Extends the polyline to join with 

the segments (segment to join and the 

nearest segment of the polyline) of same 

type. The segments are joined by 

extending or trimming method. 

 

Add – Always creates a line segment to 

join the segment to join and the nearest 

end point of the polyline. 

Both – System defines either the Extend 

or Add method, whichever is suitable. 

To join the polylines, the fuzz distance 

must be larger than 2.8 



 

 Previous – Prompts the previous vertex of the polyline 

 Break – Breaks the polyline segment between two selected vertex. 

 

 Insert – Inserts segment between two selected vertex. 

 

 Move – Moves the selected vertex to a new location. 

 

 Regen – Regenerates a polyline.  

 

 Straighten – Straighten a polyline between selected vertex. 

  

 Tangent – Specifies a tangent direction for later use. 

 

 

 

 

 Width – Specifies width to polyline. Width may vary from vertex to vertex. 

 

 
 

Fit – Converts any polyline into a 

smooth curve consisting of arcs joining 

vertices to create an arc-fit polyline. 

 



 

 
  

 

Decurve – Removes all spline type or fit polyline and straighten the vertices. 

 

 

 

 

 

Reverse – Reverses the order of vertex. Using the option Reverse will prompt the vertex from right to left or 

down to up instead of left to right and up to down respectively. 

Undo – Reverses the modifications for the last PEDIT command. 

Working with Straighten, or Break command,  

‘Next’ prompt us the next vertex,  

‘Previous’ prompt us the previous command, and 

 ‘Go’ executes the operation. 

Polyline – It is a planar object with the combination of line segment and arc segment. 

 

Polygon 

Polygon creates an equilateral closed polyline 

You can specify the different parameters of the polygon including the number of sides. The difference 

between the inscribed and circumscribed options is shown. 

Spline – Converts a polyline into a spline 

type polyline. 

Ltype Gen – When Ltype Gen is off, it 

always generates a dash at the start 

and end of each vertex. This command 

is not available on tapered segments. 
 



 

 

                                          The above figures are polygon.  

Figure A is an inscribed polygon, i.e. the polygon is inside the circle and the corners of the polygon are coincide 

to the circumference of the circle. 

Figure B is a circumscribed polygon, i.e. the sides of the polygon are tangent to the circle. 

 

To draw a polygon(circle radius known) the parameters required are hereby followed: 

 No of sides of polygon.  

 

 Centre point of the circle.  

 Type of polygon (inscribed in circle-the corners of the polygon will met on the circumference of the 

referred circle or circumscribed about circle-the centre point of the sides of polygon is tangent to the 

referred circle.) 

 

<I> - Inscribed in circle.    <C> - Circumscribed about circle 

 Radius of the circle. 

 

  

 

 

 

 

 

We can rotate the polygon (direction) while defining the radius.  

 

 

 



 

 
 

Now if we have to draw a polygon with length of the sides is given we will follow these steps: 

 No of sides of polygon. 

 Select the ‘Edge’ option.   

 
 Define the length of the side of polygon. 

  
 We can rotate the polygon while defining the side of the polygon. 

 

Polygon – A planar or 2d object covered by minimum 3 sides of equal length is a polygon. 

 
 

 

Rectangle  

Rectangle creates a rectangular polyline 

Creates a rectangular polyline from the specified the rectangle parameters (length, width, rotation) and the 

type of corners (fillet, chamfer, or square).  

 

The above figure is a rectangle. Here we can see each angle is 90o and the opposite sides are equal. 

 



 

 

To draw a rectangle the following methods exist as per parameters known to us.  

First we have to define the start point (first corner point, point may be coordinate value or constraint) of the 

rectangle.  

  

Second corner point (point at which the diagonal through first corner point connecting, point may be 

coordinate value or constrain)  

 

 Area of the rectangle and length or width 

 

Select Length or Width 

 Or 

 

 
 

 Dimension of the rectangle i.e. length and width 
 

 
And 

 

Insert point 1 and 2, or 

 point A and B 

a = start point of the rectangle and specify the area 

 

 
 

  

 



 

 
Defining the parameters we have to confirm the position of the rectangle. Here we have to locate the 

quadrant for the rectangle relative to the defined base point.   

 

Rotation – We can rotate the rectangle by ‘Rotation’ command at any angle w.r.t. the horizontal axis. 

 

  

or define rotation angle by Pick points. 

 

This is the option where we can define the angle by two points. 

  &  

Similar to defining a line segment, which defines the rotation of the rectangle. 

 

Elevation – This option used to draw the rectangle deviating the plane upward or downward to the normal. 

The rectangle created is parallel with working plane. 

 

 This is a distance input to create the rectangle on up or down, parallel to the drawing plane. Positive sign 

moves up (+Z Direction) and negative sign moves down (-Z Direction).  

Rotation angle =  45o  



 

 

 

 Thickness – By this option, we can provide thickness to the rectangle. This converts the rectangle into a solid. 

 

  

Width – using this option, we can provide width to the sides of the rectangle. 

 

 

 

Chamfer – To make chamfer at the corners of the rectangle, define the chamfer distance for two adjacent 

sides (may not be equal). 

 

and 

 



 

 

 

The second chamfer distance is by default equal to the first chamfer distance; here we can press enter to 

accept the equal value. However, we can change the value, i.e. 7. 

  

Note : The distance of the side must be bigger than the total chamfer value, else the chamfer will not be 

accepted and sharp corner will form, i.e. the sides must be more than 12 unit (7+5). 

 

 

 

 

 

 

>> If the length of the side is less than (given fillet radius X 2), no fillet will create at the corners. 

>> In case, the length of the side is equal to (given fillet radius X 2), a polyline arc is created. 

 

Now, First chamfer distance = 5 and 

 Second chamfer distance = 7 

Therefore, ‘a’ is the start point of the rectangle. 

Now, the first chamfer distance will be at the 

start point of the rectangle along horizontal axis 

and will alternate at every corner of the 

rectangle. a 

Line 
B 

             Line A 

Fillet – For corner rounding, define the radius of fillet. 

 

 

 

The length of the side must be larger than (given fillet radius X 2) 

i.e. if the fillet radius is 5 unit, then the length of the side must 

be larger than (5 X2 = 10 unit), so that the fillets must adjust. 



 

If we define chamfer, fillet, thickness, or width to any particular rectangle, again we have to set the default 

value to zero to turn off the features. Otherwise, all the rectangles will be created with same feature defined 

previously.  

Rectangle – the planar object covered by four sides is a rectangle. Each angle is right angle (90o) and opposite 

sides are of equal length. 

 

 

 

Arc 

Arc creates an arc using three points 

 

 

Defining any three points to draw the arc following these three points. The point at which the bisectors of the 

lines connecting any three points is the centre point of the circle or arc on these three points.  

Apart from this, we can draw arc with some other parameters are hereby defined 

Parameter 1 parameter 2 parameter 3 (any one) 

start point center point end point / included angle / length of chord. 

start point end point center point/included angle/radius/direction of curve. 

 

Line ab and bc connecting the points a, b, and c. 

x and y are the midpoints of the line ab and bc 
respectively. 

Drawing perpendicular lines from point x and y, 
meets at point o. 

Therefore, o is the center of the arc which connects 
point a, b, and c.  

oa = ob = oc = radius of the arc 

 



 

 

Direction of Arc : 

3 Points – Depends on the selection of the points. 

Start, Center, End – Counterclockwise from start point. 

   

 

 

 

Start, Center, Length – Counterclockwise from start point. 

Start, End, Angle – Direction of arc is same as Start, Center, Angle method. 

 

 

 

 

 

 

 

 

Center, Start, End – Counterclockwise from start point. 

Start, End, Radius – Creates minor arc counterclockwise 

from start point if the radius value is positive and major arc 

if the radius value followed by (-) sign. 

 

Start, Center, Angle – Include angle is always a 

positive value, it always creates arc in 

counterclockwise rotation from start point. The 

angle value followed by (-) sign creates arc in 

clockwise rotation from start point. 
 

 

Start, End, Direction – Here, Direction defines the angle of 

the line tangent to the said arc. Positive angle creates arc 

in clockwise rotation from the start point and negative 

angle rotates the arc in counterclockwise direction from 

start point.     

Now, if we enter value from 0o to 90o, a 

minor arc created and value between 90o to 

180o creates a major arc. 

 



 

Center, Start, Angle – Creates an arc at counterclockwise rotation from the start point. The rotation of the arc 

is clockwise if the angle value is followed by (-) sign.  

 

 

Arc – Arc may be defined as a part of a circle or if any curve is extended maintaining the same parametric path 

(radius) and form a circle is called an arc.  

 

 

Circle  

Circle creates a circle using a centre point and a radius 

  

 

Apart from this, the other options to draw a circle are: 

 

 
 

 

To draw a circle define the centre point of 

the circle and radius or check the diameter 

option and enter the value of diameter of 

the circle. 

 

3P – 3 point method is to define any three points which cover 

the circle. It is same like drawing three point arc. 

2P – any 2 points is defining the diameter of the circle 

without defining the centre point. 

 

 

Center, Start, Length – 

Creates a minor arc for 

positive value at 

counterclockwise direction 

from start point and major 

arc for the Negative value of 

the chord length.  

 



 

 

 

 

 

 

 

 

 

 

 

Circle – A planar object bounded by a curve and any point of the curve is at equal distance from its centre may 

be defined as a circle. 

 

To draw a 3-Points Arc with Center is inaccessible 

We have learnt about 3-Points Arc and to locate its center. 

Now, we will learn the method of creating an arc by three points if the center of the arc is outside the drawing 
area or is inaccessible. 

Tan, tan, radius – two segments on which the circle is 

tangent and the radius of the circle. 

 

 

Tan, tan, tan – any three segment to which the circle is 

tangent. 

 
 



 

 

Let, A, B, and C are the three given points. 

Now, draw two arcs from center point A and C with radius = AC. Join A, B and B, C with straight lines and 
extend them to the arcs, which intersects at M and N respectively. 

Now divide the arcs AN and CM (above point M for the arc CM and below point N for the arc AN) into some 
equal parts. 

On arc CM we get points P, Q, R, and S. On arc AN we get points P’, Q’, R’, and S’.  

Now, join the points on arc AN (P’, Q’, R’, and S’) with point C and points on arc CM (P, Q, R, and S) with point 
A by straight lines. 

Here we get the intersection points (1, 2, 3, and 4). Now, if we connect the intersection points with uniform 
curves, we will get the arc between point A and B.    

Similarly, divide the arc AN (above point N) and CM (below point M). Join the points from C and A respectively 
by straight lines.  

Connect the intersecting points (5, 6, 7, 8, and 9) by uniform curves to get the arc between B and C.   

To determine the center and radius of a circle, when, tangent to three lines 



 

 

AB, CD, and EF are the three lines. The circle XYT is tangent to the three lines.We have to determine the center 

and radius of the circle. 

Extend the line AB and CD to meet at point M and extend line CD and EF to meet at point N. 

Line MR and NP bisects the angles <BMD and <CNF. 

Line MR and NP intersects at point O. O is the center of the circle drawn tangent to the lines AB, CD, and EF. 

Now, draw a line perpendicular on line EF, passing through point O. Consider OT is the line Perpendicular on 

EF. Now OT is the radius of the circle. 

 

To determine the location of a circle of given radius, when, the circle is tangent with two lines 

 

Let, AB and CD are the two lines on which the circle is tangent and radius of the circle = 1.0.  

Offset (draw parallel lines) the lines AB and CD at the distance equal to the radius of the circle. The offset lines 

PQ and RS intersects at point O.  

Now, O is the center point of the circle.   

To determine the location of a circle of given radius, when, the circle is tangent with a line and a circle 



 

 

The circle TUV is tangent to line AB and circle QRS. P is the center point and R1 is the radius of the circle QRS. 

Offset the line AB (draw parallel line) at the distance equal to the radius (R2) of the circle TUV. CD is the offset 
line. 

Draw an arc of radius (R1 +R2) as point P is the center point of the arc. The said arc intersects line CD at point 
O. 

Now, point O is the center point of the circle TUV that is tangent to line AB and circle QRS. 

 

To draw an arc of given radius and tangent to two arcs or circle and determine its side of tangency 

 

Here, we have two circles ABC and LMN and their center point is O and P  and radius is R1 and R2 respectively. 



 

We have to draw a circle with radius R and tangent to the circles ABC and LMN. 

Now, draw a circle or arc, as O is the center point and radius = (R + R1). Draw another circle or arc, as P is the 
center point and radius = (R + R2). 

Let, A’B’C’ and L’M’N’ are the two circles which intersects each other at point S and T.  

Now, if we draw circles as S or T will be center point and radius = R, the circles will be tangent to circles ABC 
and LMN. 

Here, circle A’’B’’C’’ and L’’M’’N’’ are the circles with radius R, tangent to circles ABC and LMN and their center 
points are S and T respectively. 

Note : From this method we can create a concave arc relative to the circles the arc is tangent with.  

 

Here, we have two circles ABC and LMN and their center point is O and P  and radius is R1 and R2 respectively. 

We have to draw a circle with radius R and tangent to the circles ABC and LMN. 

Now, draw a circle or arc, as O is the center point and radius = (R - R1). Draw another circle or arc, as P is the 
center point and radius = (R - R2). 

Let, A’B’C’ and L’M’N’ are the two circles which intersects each other at point S and T.  

Now, if we draw circles as S or T will be center point and radius = R, the circles will be tangent to circles ABC 
and LMN. 

Here, circle A’’B’’C’’ and L’’M’’N’’ are the circles with radius R, tangent to circles ABC and LMN and their center 
points are S and T respectively. 

Note : From this method we can create a convex arc relative to the circles the arc is tangent with.  

 



 

 

Revision cloud  

Revision cloud creates a revision cloud using a polyline 

You can create a new revision cloud by dragging your cursor, or you can convert a close object such as an 

ellipse or polyline into a revision cloud. Use revision clouds to highlight part of a drawing that are being 

reviewed.  

We can drag the cursor covering the area of the drawing to be reviewed.  

 

Or we can convert any segment (line, arc) or object (created using polyline i.e. circle, rectangle, ellipse etc). To 

convert into revision cloud, check the option ‘Object’ and select the segment or object to be converted. 

 

 

 

To reverse the revision cloud, we get the option ‘Reverse direction’. Select ‘Yes’. 

 

Modification of revision cloud : 

 ‘Arc length’ - Control the size of the arc according to our requirement. Maximum & minimum size of arc 

length for adjustment of the total length of the segment or area covered. 

  

Minimum length of arc = 2 

Maximum length of arc = 4 



 

 

‘Style’ - Change the pattern of the revision cloud into ‘Normal’ or ‘Calligraphy’. 

 

Revision cloud – This is a feature to highlight any part of the drawing for revision. 

 

Spline  

Spline creates a smooth curve that passes through or near specific points 

Spline creates curves called non-uniform rational b-spline (NURBS), referred to as splines for simplicity. 

Splines are defined either with fit points, or with control vertices. By default, fit point coincide with the spline, 

while control vertices define a control frame. Control frames provides a convenient method to shape the 

spline. Each method has its advantage. 

 

Object option used to convert any spline-fit polyline into spline.  

 

 

Here we can see the arc 

length is in between 2 and 4. 



 

Knots 

 

 

Start tangency / End Tangency – Here, we have to define the tangent condition of the spline at start point and 

end point. 

  

Tolerance – The spline deviates from the Fit Points from this distance. The start and end Fit Points are not 

applicable for tolerance. When tolerance = 0, the spline passes through the Fit Points. 

 

While creating a spline with Control vertices, we can create from degree 1 to degree 10. 

 

 

Modify – Object – Spline for more spline editing option. 

 

Spline created with several Knots 

type using the same Fit Points. The 

vetex of the polyline (colored red) 

used as Fit Points.  

The spline is tangent to line (colored red) 

at the start point. 



 

Close – Closes an open spline connecting the start point and endpoint. 

 

Open – Opens a closed spline removing the last segment drawn connecting the start point and endpoint. 

Join – Joins any line, arc, polyline, or spline to a spline with endpoints coincide to form a larger spline. It forms 

a kink joint with C0 continuity.  

 

Fit data – Edits the Fit Points. 

 

Add – Adds new Fit Point relative to any other existing Fit Point. The direction at next fit point automatically 

highlighted. 

 

Close – Closes an open spline connecting the start point and endpoint. 

Delete – Deletes any existing Fit point. 

 

Kink – Creates a Fit Point on spline that don’t follow the curvature or continuity. 

 

Move – Moves any existing Fit Point to new location on the spline. 



 

 

 

Tangents – Changes the start point and endpoint tangency. 

Tolerance – changes the Fit Point tolerance value. 

Edit Vertex – Edits the Control Vertices frame. 

 

Add – Adds vertex. 

Delete – Deletes existing vertex. 

 

Move – Moves existing vertex to a new location on frame. 

 

Convert to polyline – Converts a spline into a polyline. We have to define the precision value (integer between 

0 – 99) to match the resulting polyline with the spline. Low precision value matches closer than any higher 

value. PLINECONVERMODE system variable controls either line or arc segment after converting to polyline. 0 = 

line segment, 1 = arc segment. 

 

Elevate order – Increases the degree of 

spline up to the value 26. 

Purge – Converts the Fit Points into Control 

vertices. 

Weight – Changes he weight value for 

selected vertex. Larger value moves the 

spline towards control frame. 

 



 

 

Ellipse  

Ellipse creates an ellipse or an elliptical arc 

The first two points of the ellipse determine the location and the length of the first axis. The third point 

determines the distance between the centre of the ellipse and the end point of the second axis.  

  

The above figure is an ellipse where it is shown that –  

Length of first axis (a-b) = Diameter of first circle i.e. major dia, 

Distance from centre of ellipse and end point of the second axis (o-c) = Radius of second circle i.e. minor dia 

Here we have these options to draw an ellipse. 

 Centre – Define the centre point of the ellipse (centre point of major and minor diameter.) then define 

the radius of both circle.  

Here, radius of circle = ½ x axis length 

 

 
 Axis, end – Define the start point and end point of first axis. 

Here, distance between start point and end point = diameter of first circle. 

Then define the distance from centre of the ellipse and end point of second axis. 

 
Here, distance between the centre of the ellipse and the end point of second axis = ½ X second axis 

length or radius of second circle. 

Define point o, then define distance o-a and o-b 

Define point a, then define the distance ab and oc 



 

       
 

From ‘Rotation’ option we can control the diameter of minor axis. The rotation is done around major axis (the 

axis defined first) where, 

Rotation of major axis at 0o and 180o , the length of major axis = length of minor axis. At 90o, the length of 

minor axis is 0. 

 

PELLIPSE – This system variable creates ellipse of two types. 

Value = 0, creates true ellipse 

Value = 1, creates ellipse shaped polyline object. 

 

 

Ellipse – It is a regular oval consist two circle of different diameter at same centre point.  

 

Ellipse arc  

Creates an elliptical arc 

The first two points of the elliptical arc determine the location and the length of the first axis. The third point 

determines the distance between the centre of the elliptical arc and the end point of the second axis. The 

fourth and fifth points are the start and end angles. 

   

We can specify an angle while defining 

the distance of first axis in either option 

(centre or axis, end) for rotation of the 

ellipse. 

The circle rotate around X axis to create 

the second diameter for ellipse 

 



 

The above figure is an ellipse arc where it shown that it is a part of an ellipse between two points. 

To draw an ellipse arc, it is same like drawing an ellipse. To define the segment we have to define the star 

point and end point of the arc. The start point and end point is defined by angle. Angle is defined with respect 

to first axis starting from first point and the angle of end point is defined either around first axis or an included 

angle (select Include angle command). 

 

 

 

 
 

Ellipse arc is always drawn ccw.  

Ellipse arc is a segment of ellipse. 

 

 

 

 

Donut – It is a basic shape and a polyline. Circular with thickness. 

  

 

 

      

 

To create a solid filled Donut, specify the inside diameter = 0 

 

Ray – Ray creates line of infinite length from a point at any angle.  

 

 

 

For using the Include angle option, we have to enter 

the start angle, which is an absolute angle, i.e. 45o. 

Then we can either enter the end angle or include 

angle. 

To draw a donut, define the inside 

and outside diameter. Locate the 

donut with the centre point 

reference. 

 

It has a start point but the length is infinite. 

Like construction line, rays used to create 

construction and reference lines, and for 

trimming boundaries.  

 

 

 

 



 

 

 

 

Multiline   

Multiline or mline creates multiple parallel lines 

This is an option to draw a set of parallel lines following the process of drawing lines. We can create 1 to 16 

multiline each is called element. 

 
‘Undo’ option erase the last drawn mline segment from the current series of segments and return to previous 

point. 

‘Close’ option join the end point of last drawn segment to start point of first segment in a series of segment. 

Minimum three segment required to use the option ‘close’. 

‘Justification’ option is to locate the position of the mline. 

 Top – Coordinates defined for start point of upper line. 

  Zero – Coordinates defined for midpoint joining the two lines at start point. 

 Bottom – Coordinates defined for the start point of bottom line. 

 

‘Scale’ option manages the width of multiline. This is a factor based on the element offset defined in Multiline 

style. 

 

Click Format -> Multiline Style… for more options 



 

 
  

The ‘Add’ and ‘Delete” option adds or removes elements respectively.  

Under ‘Offset’ we can define the width of elements. (+) and (-) sign flips the direction of elements.  

 

  
 

Modify -> Object -> Multiline… for more editing option of multiline. 

If we check the Display joints 

option, we can see the joints at 

every endpoint. 



 

 
 

Note – Some of the editing command are not applicable on multiline. Such as Fillet, Chamfer, Break, Lengthen, 

Offset. 

To apply these commands on multiline, we have to Explode the multiline and convert it into normal line and 

arc segments. 

 

Point – creates points. 

 Single point – Create a single point. 

 Multiple point – Creates multiple points. 

 Divide – Divide any segment in equal length. 

 Measure – Create point on desired length from reference. 

Click Format -> Point Style… for more options 

PDMODE system variable to define point style.  

 
PDSIZE system variable to define the size of point. 

0 – Set Size Relative to Screen. 
0 defines the size at 5% of screen size. A negative value input set 
the percentage. The displayed point size don’t change to Zoom in 
or out. 
 
1 – Set Size in Absolute Units.  
A positive value input set the size in absolute units. The displayed 
point size change to Zoom in or out. 
 



 

 
 

 

 

Region   

Converts an object that encloses an area into a region object  

Regions are two dimensional areas you create from closed shape or loops. Closed polylines, lines, and curves 

are valid selections. Curves includes circular areas, circles, elliptical arcs, ellipses, and splines.  

You can combine several regions into a single, complex region.  

 
 

Cross intersecting and self intersecting boundaries are not converted into regions. 

Trim, extend, break, chamfer or fillet is not be done on regions. Explode the region before modification. 

 

 

Boundary  

Converts any area enclosed by any segments series of segment, or polyline into boundary object. 

Here, we can see 3 regions are created in figure-2. 

In figure-3, region 2 and 3 is Subtract from region 1 

to create a complex region. 

When converted into regions, the original object or 

boundary is deleted. Boundary retains only when 

system variable DELOBJ is set to 0.  



 

 
 

 

 

 
 

 

HPISLANDDETECTION 

0 – Normal. Hatches island within islands 

1 – Outer. Hatches only areas outside of islands 

2 – Ignore. Hatches everything within boundary 

 
Wipeout – Wipes the selected area (enclosed) from any drawing (any object, text). 

Frames are selected from series of points. Alternatively, we can select any close Polyline created by line 

segment only. 

 

Pick Points – Determines a boundary from existing 

objects that form an enclosed area around the specified 

point. 

Island detection – Controls whether an internal closed 

boundaries, called islands, are detected. 

(HPISLANDDETECTIONMODE system variable) 

0 -> Off. 

1 -> On. (Hatches or ignores according to 

HPISLANDDETECTION system variable.) 

 

Object type – Create boundary with Polyline or Region. 

Boundary set – Current viewport (creates boundary 

with pick point around closed area.  / Existing set 

(defines boundary with pick point from set of boundary 

objects) 

Figure 1 – Boundary detected by pick point created by 

several objects. 

Figure 2 – Boundary selected (circle). Ignores detecting  

other closed areas by several objects. 



 

 

 
 

While selecting polyline: select ‘Yes’ to erase the polyline or ‘No’ to retain the polyline. 

Frame :   ON – Frames are displayed and plotted. 

   

    OFF – Frames are not displayed or plotted. 

   

    Display but not plot – Frames are displayed but not plotted. 

   

 


